
However, transferring a license to a different computer is easy.

To transfer a license, please complete the following steps:
‣ On your old Mac, choose “VPN Tracker 5“ > “Deactivate VPN 

Tracker“

The license will now be available for activating the software on 
your new Mac.

‣ Install VPN Tracker on your new Mac

‣ On your new Mac, activate VPN Tracker with your equinux ID 
(s. above)

VPN Tracker will automatically fetch the free license.

Note From now on, the software cannot be used on the 
old machine. To transfer the license back, just reverse 
the process described above.

Installing a Deployment Bundle
If your administrator provided a deployment bundle, 
installation, activation, and configuration can be completed in 
a single step.

Note Installing a deployment bundle requires Internet 
access and an administrator password on your Mac.

‣ Double-click the deployment bundle (a disk image) to open 
it

‣ Copy the VPN Tracker application to your Applications folder

‣ Eject the disk image by dragging it to the Trash

‣ Double-click the application icon

VPN Tracker will ask you to enter the decryption password sent 
to you by your administrator

‣ Enter the decryption password

VPN Tracker will now ask for an administrator password to 
complete the installation.

 9











‣ Check “Store in Keychain” if you don’t want to enter the pre-
shared key manually each time you establish the connection

‣ When editing certificates, please select a local and a remote 
certificate for this connection

‣ Click “OK”

If your gateway requires Extended Authentication (XAUTH):

‣ Check the XAUTH box, if applicable

‣ Select the XAUTH type (usually always)

‣ Click “Edit”

or

‣ Right-click the connection

‣ Choose “Edit XAUTH Credentials” from the contextual menu

‣ Enter your user name and password

Identifiers
The identifiers are used to identify the VPN peers during the 
first phase of the tunnel establishment, and to select the 
appropriate IPSec configuration. For both the local and the 
remote identifier, you need to specify both a type and a value.

To configure identifiers for your connection:
‣ Select a type from the pop-up menu for the local identifier

‣ Enter a value (if applicable)

‣ Select a type from the pop-up menu for the remote identifier
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‣ Enter a value (if applicable

‣ Check “Verify remote identifier” to enforce verification of the 
remote identifier

DNS
A VPN tunnel can be configured to use a remote DNS server 
(so your Mac can resolve hostnames from the remote 
network).

To enable remote DNS:

Check the box next to “Use Remote DNS Server“

When using Client Provisioning or Mode Config, you can 
choose to receive DNS settings from the VPN gateway.

Check “Receive DNS Settings...“ if applicable

‣ Enter a DNS server’s IP address

‣ Enter a search domain (optional)

‣ Choose between Split DNS and Global DNS

Split DNS will use the remote DNS server only for the search 
domains specified before, while Global DNS will use it for all 
domains.

Note Global DNS will work only when the remote DNS 
server can resolve public hostnames (like 
google.com) directly or indirectly.

Advanced Settings
The “Advanced” tab contains general settings which are usually 
device-specific, but not connection-specific (although you can 
configure connections .  encryption and authentication 
settings. When using a device profile without any 
modifications, you usually don’t have to visit this tab.
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For custom devices, VPN Tracker preselects a standard set of 
proposals etc. We will highlight only the parameters which 
require special attention.

‣ The exchange mode for Phase 1 is either “main” or 
“aggressive”

‣ There needs to be at least one set of matching proposals 
(combination of encryption, hash algorithm and Diffie-
Hellman group) for Phase 1 between the gateway and VPN 
Tracker. 

‣ For Phase 2, the requirement is the same. If a Diffie-Hellman 
group is specified for Phase 2 on the gateway, please make 
sure to enable Perfect Forward Secrecy (PFS)

Note It is usually safe to select multiple algorithms, but 
some devices stop responding when being sent 
more than one proposal

‣ Synchronize the lifetimes for both Phase 1 and Phase 2 with 
the gateway. Lifetime differences might not prevent a tunnel 
from being established, but they will cause problems when 
negotiating new keys (re-keying)

For the other advanced settings, there’s a general rule: If you 
don’t know them, don’t touch them. You might have to edit 
them when your custom connection fails, but it is 
recommended to try connecting with the defaults first.
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Deployment
As an admin, you probably don’t want to 
configure each user’s Mac manually. VPN Tracker 
Professional lets you export connections or even 
complete deployment images.

Exporting Connections
Older version of VPN Tracker Professional offered an export 
function that would create encrypted connection files. VPN 
Tracker 5 Professional offers several new options when 
exporting connections.

A connection file can now contain one or more connections, 
which makes it much easier to distribute a complete set of 
connections.

To export connections:
‣ Select one or more connections

‣ Select “File > Export Connection...”

‣ Provide an encryption password

‣ Select your preferred options for the connection file (s. 
below)

‣ Click “Export”

Locking Connections
As an administrator you probably don’t want all your users to 
know about the pre-shared key of your company’s VPN 
connection, and you certainly don’t want them to edit the 
connection settings. By locking a connection, you can 
effectively prevent any user from seeing sensitive information 
and from damaging his or her VPN access.
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To create a locked connection:
‣ Check the “Lock connection(s)” box when exporting 

connections

You might want to allow certain users to know about the 
settings. This is what the unlock password is for – if you send 
the encryption and the unlock password with a locked 
connection file, the recipient will be able to see (and edit) the 
settings.

Note It is highly recommended to choose different 
passwords for encrypting and locking the connection 
file, but this is not enforced by VPN Tracker.

To specify an unlock password:
‣ Check the “Unlock password” box

‣ Enter an unlock password

For increased security, you can even hide all the settings 
(including the gateway address) from the users.

To hide all settings for a connection:
‣ Check the “Hide Basic and Advanced settings...” box

Note This setting only applies to a locked connection. If a 
user has access to an unlock password, he/she can 
view all settings.

Deployment Bundles
To install VPN Tracker for a large number of clients, there’s an 
even easier way to distribute VPN Tracker.

The application lets you create bundles (in DMG format) 
containing a license, connection profiles and the application 
itself. This bundle makes the installation process quite simple 
(see “Installing a Deployment Bundle”).

To prepare deployment:
‣ Select one or more connections

‣ Select “File > Prepare Deployment...”

The dialog for exporting connections will appear. Please follow 
the instructions for exporting connections above. After clicking 
“OK”, VPN Tracker will connect to the equinux licensing server.

‣ Login with your equinux ID and password

‣ Click the green “+“ symbol to add unused licenses to the 
deployment cycle

‣ Enter your company name

‣ Read and accept the Voucher Agreement by checking the 
box next to it 

If you want to send the deployment bundles using Apple Mail:

‣ Check the appropriate box

‣ Make sure to specify an email address for each bundle/
voucher

‣ Modify the mail subject and message
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‣ Click “Create Bundle(s)”

VPN Tracker will start creating the deployment bundle(s).

All bundles will be stored on your harddisk. If the email option 
was checked, it will also create email messages (one per 
bundle/voucher) in Apple Mail.

Distributing Licenses
If you only need to distribute licenses, you can do so using our 
license manager.

To distribute license vouchers for VPN Tracker:
‣ Open https://www.equinux.com/eqnetwork/licensemanager/

issue_voucher.html

‣ Login with your equinux ID and password

‣ Click the green “+“ symbol to add unused licenses to the 
deployment cycle
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‣ Check the “Password Protection” box (this is not required, but 
highly recommended

‣ Type and retype a password

If you want the licensing server to send the mails for you:

‣ Check the “Send vouchers by email” box

‣ Make sure to specify an email address for each voucher

‣ Specify a reply-to address (so users can contact you if 
something goes wrong)

‣ Modify the mail subject and message

‣ Click “Create Voucher(s)”

The vouchers will automatically be stored on your harddisk. If 
the email option was checked, each user will be sent a 
message from licensing@equinux.com with his/her voucher as 
an attachment.
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Troubleshooting
Sometimes, your connection might not work as 
expected.
There are two major issues which can keep a connection from 
being established: incorrect configuration and local routers not 
compatible with VPN traffic.

Before contacting your network administrator or equinux 
technical support, please take a look at the connection’s log 
file.

Known Limitations
There are some limitations of a VPN connection compared to a 
direct connection to a Private Network.

‣ Bonjour: As Bonjour Chat is not supported over a VPN 
tunnel, you’ll need to use iChat server in order to chat 
remotely.

‣ Browsing the network: You can’t “browse” the remote 
network as you’re normally used to. You need to connect to 
each machine manually, using its IP address or hostname.

These limitations are not bugs, but inherent to the 
technologies involved.

Connection Log
Please do the following:
‣ Click the yellow triangle next to the slider

VPN Tracker will display the connection log and describe in 
plain English what went wrong.

Log Levels
If you’re familiar with the details of IPSec, you can also increase 
the log level.

To see more information in the connection log:
‣ Select a connection
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‣ Expand the connection list by clicking the expansion button

‣ Click the “Log” tab

‣ Switch the log level to a higher level

 

VPN Environment Manager
In some cases, the local router will not handle VPN traffic 
correctly. The VPN Environment Manager analyzes the VPN 
capabilities of your router, and stores the results. Based on 
these results, VPN Tracker will pick the right communication 
method when connecting through this router.

To test the router, please do the following:
‣ Select “Help > VPN Environment Manager...”

‣ Click “Continue”

VPN Tracker now contacts a VPN gateway at equinux and tries 
to establish a connection. It conducts three different tests to 
check whether the local router supports IPSec Passthrough 
and/or two variants of NAT-Traversal.

Note The VPN Environment Manager needs to run only 
once for each router (network environment).

‣ If all goes well, you will see three green checkmarks stating 
that your router is fully compatible with IPSec. The downside 
is that any problem you experienced is caused by something 
else

‣ If the local router does not support IPSec Passthrough or 
NAT-Traversal, you probably need to change your VPN 
Tracker and/or gateway configuration
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‣ If it supports neither IPSec Passthrough nor NAT-Traversal, 
you probably have to exchange the local router

Please refer to “IPSec Explained“ for details on VPN traffic and 
NAT-Traversal.

Application Firewall
When using Mac OS X 10.5.1 or later with the application 
firewall enabled, you need to allow VPN Tracker to establish a 
connection explicitly. The option “Allow only essential services” 
will keep VPN Tracker from working properly.

Creating a Technical Support Report
If you cannot figure out how to solve the problem with the 
help of the log hints and/or the VPN Environment Manager, 
you should send a Technical Support Report (TSR) to equinux 

Support.

To create a Technical Support Report:
‣ Click the yellow triangle next to the connection slider

‣ Click the TSR button below the log

‣ Select the options as indicated on the screenshot below
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‣ Click “Save”

‣ Enter your local administrator password to save the TSR

If you’re using Apple Mail as your default email client, a 
message to equinux Support will be opened automatically.

‣ Add your comments to the message template

‣ Send the message

For other email clients:
‣ Please create a message manually and attach the TSR

‣ Add comments to the message, if necessary

‣ Send the message

Missing Device Profiles
In many cases, the device profiles included in VPN Tracker will 
simplify setting up a device. However, the device profiles won’t 
help in two cases:

‣ The VPN gateway has not been tested with VPN Tracker, so 
there is no device profile, and equinux cannot provide 
support

‣ The gateway’s VPN settings have been modified, so the 
device profile in VPN Tracker does not match the actual 
settings

If you have administrative access to the gateway yourself, 
please refer to “Custom Devices” for instructions on creating 
new device profiles, or modifying existing ones.

If you don’t have access to the device yourself, you will need to 
contact the network administrator, as described in the next 
section.

Assisted Troubleshooting
In an ideal world, your network administrator uses a Mac and 
provided a connection profile for you to import (or even a 
deployment bundle). But in this world, you wouldn’t have to 
read this troubleshooting chapter.

If you have limited networking experience, and the VPN Tracker 
log does not help, the best solution for any configuration 
problem is to create a TSR, and send it to the network 
administrator so he/she can tell you how configure VPN 
Tracker.

Please read the following instructions carefully, so your admin 
gets all the information he/she needs to assist you.
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Sending a TSR to a Mac-based Admin
To send a TSR to an administrator using a Mac, just follow the 
instructions at the beginning of this chapter, but enter your 
administrator’s email address as the recipient.

TIP If your admin uses a Mac anyway, and there’s more 
than one Mac user to support, we strongly 
recommend to get one VPN Tracker Professional 
license, so the admin can create and export 
connection profiles.

Sending a TSR to a Windows-based Admin
A TSR is a disk image file which can be opened on Macs only.

If your administrator has access to Windows PCs only:
‣ Do not send the TSR file directly

‣ Doubleclick the TSR file to open it

‣ Copy all files and folders into a separate folder

‣ Right-click that folder and select “Create archive of...“

‣ Send the zipped folder to your administrator manually
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Appendix: Preferences
Most preferences in VPN Tracker are connection-
specific and are touched in the section regarding 
custom connections. There’s only a small set of 
truly global options.

Updates
VPN Tracker is updated regularly, and you can instruct the 
application to check for updates (and notify you). 

To make VPN Tracker check for updates automatically:
‣ Check the appropriate box in the preferences

Growl
Growl is a system-wide notification tool. VPN Tracker can 
display Growl notifications for starting or stopping 
connections, for errors or even when a connection status 
changes

To enable Growl:
‣ Check the appropriate box

‣ Activate the desired notifications

Advanced (Ports)
In certain network environments (e.g. when using  the Back to 
my Mac feature in Mac OS X 10.5), dynamic port handling is 
required.

To enable dynamic ports for IKE or NAT-T:
‣ Uncheck the appropriate box

 41



Appendix: IPSec Explained
IPSec – The Standard
Virtual Private Networks (VPN) are all about transmitting 
sensitive information over unprotected networks. This setup is 
often illustrated using a “tunnel” metaphor – protected data is 
sent through a secure VPN tunnel.

A VPN connection can, for example, link two local area 
networks (LANs) or a remote dialup user and a LAN. The traffic 
that flows between these two points passes through shared 
resources such as routers, switches and other network 
equipment that make up the public Internet.

A lot of information is exchanged using the IP protocol – the 
fundament of the Internet. Unfortunately, the IP protocol has 
no security mechanisms at all – confidentiality, integrity and 
authenticity of IP packets cannot be ensured by the protocol 
specification. This is where IPSec comes into play. IPSec builds 
on the IP specification to create secure “tunnels” within a 
public network (such as the Internet). Being fast and reliable, it 
quickly became the most established standard for VPN 
connections in IP networks. Many vendors (such as Cisco, 
SonicWALL, Watchguard, and others) offer gateways 
implementing IPSec for secure connections.

VPN Tracker also uses IPSec, and is inherently compatible with 
all devices providing a standard IPSec implementation. 
Unfortunately, some vendors decided to create “useful” 

undocumented proprietary extensions to the public standard. 
Not all of these extensions are implemented in VPN Tracker.

Using IPSec, VPN Tracker provides

‣ Privacy (via encryption)

‣ Content integrity (via data authentication)

‣ Sender authentication

‣ Non-repudiation (via data origin authentication, if using 
certificates)

Establishing a VPN Tunnel
An IPsec tunnel consists of a pair of unidirectional Security 
Associations (SAs) – one at each end of the tunnel – that 
specify the security parameters and the source and destination 
IP addresses. Since an SA defines a tunnel, the terms “SA“ and 
“(VPN) tunnel“ can be used interchangeably.

Before sending information through a VPN tunnel, the two 
partners need to obtain a secret key to encrypt and 
authenticate the data. While it is allowed by the IPSec 
specification to create such a key manually, it is both unflexible 
and potentially insecure.

In most environments, the automated Internet Key Exchange 
(IKE) standard is preferred. Strictly speaking, IKE is not part of 
the IPSec standard. It inherits from other standards (ISAKMP, 
Oakley and SKEME) and describes how to generate SAs for 
various purposes.
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Phase 1 and Phase 2
Generating SAs according to IKE requires two phases. Phase 1 
is defined according to the ISAKMP standard, and generates an 
ISAKMP-SA (or IKE-SA). Two modes are defined: The faster 
Aggressive Mode uses three messages, while the more secure 
Main Mode uses six (three two-way exchanges). Because the 
participants’ identities are not exchanged securely in 
Aggressive Mode, it does not provide identity protection.

The tunnel established in Phase 1 is used in Phase 2 (Quick 
Mode) to generate an IPSec-SA. Simply put: Phase 1 
authenticates the peers, while Phase 2 configures the actual 
VPN tunnel.

It may seem odd to use an SA (a Phase 1 tunnel) to create 
another SA (a Phase 2 tunnel), but there are a number of good 
reasons for this:

‣ A single ISAKMP-SA can be used to create multiple IPSec-SAs

‣ All authentication takes place in Phase 1, so the conversation 
in Phase 2 can be restricted to the actual IPSec parameters

‣ The separation of phases maintains the independence of IKE 
and IPSec – IKE is not restricted to creating IPSec-SAs in 
Phase 2, and IPSec-SAs can be created according to other 
standards

Proposals
In both phases, the participants need to agree upon at least 
one proposal, i.e. a combination of

‣ An encryption algorithm

‣ A hash algorithm (which is used for authentication in Phase 
2)

‣ A Diffie-Hellman group (which is optional in Phase 2).

These parameters are used to generate SAs based on a pre-
shared key or on certficates.

Authentication
To authenticate the peers in Phase 1, IKE uses either a Pre-
shared Key (PSK), or Certificates. A PSK is nothing but a 
password known to both peers. Digital certificates are 
generally regarded as the best solution for determining user 
identity with absolute confidentiality. A digital certificate is an 
electronic document used to identify a single user, a server or a 
company. Each certificate is signed by a trusted Certificate 
Authority (CA).

The two standard authentication methods can be 
complemented by Extended Authentication (XAUTH), an 
extension to IKE. XAUTH defines an additional user 
authentication in a separate phase right after Phase 1 (but 
before the beginning of Phase 2).

The user authentication can be checked against an internal 
database in the VPN device or external databases, e.g. against a 
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RADIUS or LDAP server. This allows the user to use the same 
login information for the VPN connection and other services 
(like email or file services).

The different authentication passwords tend to create some 
confusion. There are usually three passwords involved in using 
VPN Tracker:

‣ The password for the local user account on your Mac. If your 
account is an admin account, you can also use this password 
to install VPN Tracker. If not, you will need a local admin 
password for installing VPN Tracker

‣ The connection password (pre-shared key) which is usually 
unique for each connection, but shared by all users of a 
connection

‣ The XAUTH password and username are used to identify 
your VPN connection among all users connecting with the 
same pre-shared key

Encryption
An encryption algorithm is a method of converting a plaintext 
message into an alternate ciphertext message using a known 
key. The ciphertext message contains all the information of the 
plaintext message, but is not in a format readable by a human 
or computer. The ciphertext message can be decrypted to the 
original plaintext message using the same key used for 
encryption. For IPsec connections, both participants of the 
connection compute a secret key during connection 

establishment which is later used to encrypt and decrypt the 
packets.

There are several algorithms available for encryption purposes. 
The older ones (like DES) are considered to be breakable in 
principle, so it is recommended to use either 3DES or AES.

AES (Advanced Encryption Standard) is a symmetric block 
cipher algorithm approved by the Federal Information 
Processing Standard (FIPS) for use by U.S. Government 
organizations (and others) to protect sensitive information. It 
was originally developed under the name "Rijndael" as a 
candidate algorithm for a worldwide competition to develop a 
new encryption technique that can be used to protect 
sensitive information in federal computer systems. The 
competition was organized by the U.S. National Institute of 
Standards and Technology (NIST) and the U.S. Commerce 
Department's Technology Administration. VPN Tracker 
implements the AES algorithm with key lengths of 128, 192 and 
256 bits for encrypting ISAKMP and IPsec packets.

Tunnel Lifetimes
An interesting aspect of Phase 1 and Phase 2 tunnels are their 
respective lifetimes. Each SA has an explicit lifetime, after which 
it expires. This means that a long-lived Phase 1 tunnel can be 
used to establish multiple short-lived Phase 2 tunnels. The only 
requirement is that both peers use the same lifetime for a 
certain SA.
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Since a Phase 1 tunnel is only used to negotiate a Phase 2 
tunnel (i.e. there is very few data transferred through it), it is 
extremely hard to hack after it has been established. A Phase 2 
tunnel, on the other hand, is protected by a Phase 1 tunnel 
while being established, so it’s practically hackable only after it 
has been established.

So in theory, you should choose a longer lifetime for Phase 1 
and a shorter lifetime for Phase 2 for optimal security. 
Practically, it is almost impossible to hack a 3DES tunnel (or 
even an AES tunnel), even with specialized equipment.

Transport vs. Tunnel Mode
IPsec operates in one of two modes: transport or tunnel. When 
both ends of the tunnel are hosts, you can use transport mode 
or tunnel mode. When at least one of the endpoints of a 
tunnel is a security gateway, such as a router or firewall, you 
must use tunnel mode. VPN Tracker can operate in tunnel and 
transport mode for IPsec tunnels.

In transport mode, the original IP packet is not encapsulated 
within another IP packet. The entire packet can be 
authenticated, the payload can be encrypted (with ESP), and 
the original header remains in plaintext as it is sent across the 
Internet.

In tunnel mode, the entire original IP packet – payload and 
header – is encapsulated within another IP payload and a new 
header appended to it. The entire original packet can be 
encrypted with ESP.

UDP and AH vs. ESP
While a tunnel is being established, the IKE communication 
between the peers consists of UDP packets sent to port 500.

Once a tunnel is established, IPsec uses one of two protocols to 
secure communications at the IP layer. Authentication Header 
(AH) is a security protocol for authenticating the source of an 
IP packet and verifying the integrity of its content. This 
protocol is not used by VPN Tracker, because ESP provides 
superior capabilities. Encapsulating Security Payload (ESP) is a 
security protocol for encrypting the entire IP packet (in 
addition to authenticating the source and ensuring the 
content integrity like AH).

ESP ensures the privacy, authenticity and integrity of all data 
sent through an IPSec tunnel.

NAT-Traversal

Network Address Translation (NAT)
If a connection has been configured correctly, almost all 
problems can be traced back to Network Address Translation 
(NAT) and its fundamental incompatibility with IPSec tunnels.

Most of today’s internal networks are using private IP ranges 
(e.g. 192.168.36.0/24), with a NAT router acting as the default 
gateway. This router translates private IPs to a single public IP: 
The original source IP of outgoing packets is switched to the 
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public IP of the router (so all response packets are sent to the 
router directly).

If there is more than a single host in the private network  
accessing the same host, the router obviously needs to 
distinguish the response packets somehow.

This is achieved by mapping the original client’s source port 
(and its private IP address) to unique ports by the router. The 
router the relation between these addresses in a mapping 
table. When the response packet arrives at the router, it checks 
the table to find out where to send the data and translates the 
IP headers back to the originating private IP and source port.

NAT effectively prevents exposing the internal addresses and 
enables hosts with private IP addresses to communicate on the 
Internet.

NAT and ESP
How does this affect IPSec tunnels? Remember that IKE uses 
UDP packets to negotiate a tunnel, but ESP packets to transfer 
the actual data. 

The ESP protocol has no ports (unlike UDP or TCP), so the NAT 
method cannot be used to translate ESP packets from private 
to public addresses and back.

IPSec Passthrough
The simplest solution to this dilemma is called IPSec 
Passthrough. Routers supporting this technique will just send 

ESP responses back to the last host who contacted the remote 
gateway. This obviously does not work if more than a single 
host needs to establish a VPN connection.

Traversing the Problem
NAT-Traversal is generally considered a reliable and more 
flexible solution: Before sending out an ESP packet, the VPN 
participant encapsulates it by adding an additional UDP 
header.

This UDP header can be altered by the NAT router. Since the 
additional header is removed by the remote peer before 
checking the ESP packet, changing it does not affect the 
integrity of the packets.

After removing the UDP header, the enclosed packet is 
analyzed. If it is considered to be authentic and unchanged, 
the remote peer will also use NAT-T to send its response.

The only issue with NAT-T is that different drafts of the NAT-T 
specification recommend different UDP ports to use. Initial 
drafts used port 500, which caused some devices (routers) 
between the VPN peers and VPN gateway to drop the packets 
(as they expected IKE/ISAKMP packets on that port only).

Newer drafts recommend “port-floating”, i.e. a switch from UDP 
port 500 to port 4500 while the tunnel is being established. If 
the remote VPN gateway supports port floating, this should 
work fine (unless the administrator of an intermediate firewall 
did not open that port).
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Client Provisioning and Mode Config
Client Provisioning provides a means to receive configuration 
parameters from the VPN gateway. This needs to be supported 
by the VPN gateway and enabled for the connection.

There are many different vendor-specific implementations of 
Client Provisioning. VPN Tracker supports Client Provisioning 
for SonicWALL (DHCP over IPSec) and Cisco.

Mode Config is a similar, but vendor-independent mechanism 
to Client Provisioning, which usually supports fewer 
configuration parameters. VPN Tracker supports Mode Config 
connections to Cisco (Cisco’s client provisioning is an extension 
to Mode Config) and Juniper Netscreen devices.

Note Other vendors using the same implementation of 
Mode Config might also be supported, but this has 
not been tested yet.

Gateways may provide one or more of the following paramters 
using Client Provisioning or Mode Config:

‣ Local Address (virtual IP)

‣ DNS Settings

‣ Remote Networks
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